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Slide Presentation Basics  

KISS (Keep It Short and Simple) 
� Cover main points simply in the slides  

o 7 words per line 
o 7 lines per page 

� Use variety, but maintain consistency 
� Change format, fonts, or sounds when you change the subject, not at random 
� Establish a pattern for each main section 
� Use pre-set design templates for a consistent looking slides (background, color, 

font, font size, layout) 

Font / Font Size 

� Use a font size that is easy to read: 24, 36, 48, 72 

� Keep the font consistent within sections of the presentation 
� Change font size only when you want to attract attention to the change 

 

Easier to Read HARDER TO READ 
Sans serif fonts:  Arial Serif fonts:  Times New Roman 
Plain or Bold fonts Italics 
Lowercase UPPERCASE 

Using View Buttons (Bottom Left Hand Corner of the PowerPoint Window) 
 

 

Normal 
  Shows outline, slide, and notes. 

 

Outline 
  Shows presentation text in outline format.  

 

Slide 
  

Shows a single slide at a time.  

 

Slide Sorter 
  

Shows miniatures of all the slides in your 
presentation.  

 

Slide Show 
  View your presentation in one place. 

PowerPoint Objects 
Keep in mind that PowerPoint slides are made up of objects: 

� Slide title 
� Slide text (bulleted items) 
� Action Buttons 
� Graphics 
� Charts 
� Tables 
� Graphs
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PowerPoint Toolbars 
 
 

Slide Sorter Toolbar 
(Visible in the Slide Sorter View) 
 

 
Slide 
transition 

 
Slide transition effects 

 
Preset animation 

 
Animation 
preview 

 
Hide 
slide 

 
Rehearse 
timings 

 
Summary 
slide 

 
Speaker 
notes 

 
Common tasks 

 
 
 
 
 

Animation Effects Toolbar 
 

 
 
Animate title 

 
Animate 
slide text 

 
Drive-in 
effect 

 
Flying 
effect 

 
Camera 
effect 

 
Flash 
once 

 
Laser text 
effect 

 
Type-
writer 
text 
effect 

 
Reverse 
text 
order 
effect 

 
Drop-in 
text effect 

 
Animation order 

 
Custom 
animation 

 
Animation preview 
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Working with the Slide Master and Title Master 

What is the Slide Master? 
The slide master is a tool that allows you to make changes to the look of your slides without 
changing each slide individually. Make changes on the slide master and PowerPoint 
automatically updates the existing slides and applies the changes to any new slides you add.  
 

Use the slide master to make changes to text and styles: 
� font type, size, and color 
� background color 
� apply pre-set design templates 
� bullets and numbered lists 

 
The slide master contains text and footer placeholders that can be re-sized. Placeholders 
are good for inserting:   

� text for your presentation 
� the date and time 
� slide number 

Accessing the Slide Master 
 

� Open the slide master by going to the View menu / Master / Slide Master 
 
Tip:  A miniature version of the slide you were viewing when you accessed the slide master 
can be displayed by going to the View menu / Slide Miniature. This mini slide will allow you 
to see what the slide will look like as you change the slide master.  
 
Note: There is a separate master slide for the title, handouts, and notes pages. 
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Text box from drawing toolbar 
for inserting default text on 
every slide 

 

 
Slide Master 

 
 

 
 
 
 

Apply a design template: 
The Azure design template will appear on every slide 

(The design template effects the background color, font, font colors, font size, and bullet style and placement)

Placeholder for the slide title 

Placeholder for the slide text 

Footer placeholders for 
date/time and slide number 
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Title Master 
 

Use the Title Master to create a different look for your title slides. The title master affects only slides that use the Title Slide layout.  
 

� To access the Title Master: Go to View menu / Master / Title Master 
 

 
 
 
 
Tip:  Finish working on the slide master before changing the title master. Any formatting that's changed on the slide master also 
changes the title master.  

Placeholder for the slide 
subtitle 
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Apply a Design Template 
PowerPoint comes with a variety of design templates. Design templates contain preset 
color schemes, slide and title masters with custom formatting and styled fonts. When 
you apply a design template to your presentation, the slide master, title master, and 
color scheme of the new template replaces the slide master, title master, and color 
scheme of the original presentation. After you apply a design template, each slide you 
add has the same custom look. 
 

� Change the design template by going to the Format menu / Apply Design 
Template 

 

Tip: If you create a special look for one of your presentations, save it as a custom 
template. 

Changing the Slide Background 
 

� To change the background color of the slide go to Format menu / Background 
 

There are many choices for filling in the background of your slide. A small window 
previews how your choice will look in the current color scheme of the presentation. 
 

You can choose to fill the background with one of the colors defined in the current 
template or you choose More Colors… to pick a new color with the Standard or 
Custom tabs. Other choices for the background are available with Fill Effects... 
 

� Click OK when you have finished making changes to the background 
� Click Apply to change the background on an individual slide 
� Click Apply to All to change the background on all slides of the presentation, 

including the slide master 
 

 

Fill Effect 
 

Description 
 

 

Gradient 
 

Fills the background with: 
� A blend of one color and a shade of that color 
� A blend of one color to another color 
� A series of preset blends  

 
Tip:  In order for text to be legible it needs to be light on a dark background or 
dark on a light background. If your background varies from light to dark, 
somewhere on the slide your text will be difficult to read. 
 

 

Texture 
 

Fills the background from a choice of textures such as: stone, cloth, wood, 
paper, etc. 
 

 

Pattern 
 

Fills the object with a pattern in two colors.  
 

 

Picture 
 

Fills the background with a picture imported from a file. PowerPoint will enlarge 
or reduce the picture size to fit in the screen.  
 

Note:  Image quality will change when enlarging or reducing a picture. 
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Changing Bullets and Numbered Lists 
 

� To change bullets go to Format menu / Bullets and Numbering 
 
You have a choice of several styles of bullets and numbered lists. Change the font, size 
and color of the bullets. Remember you are able to change bullets on individual slides 
or opt not to use bullets at all. 
 

Use the slide master to change the font, style, color, and line spacing on all your bullets 
and numbered lists.  

� Place the cursor in the line of text you want to change 
� Highlight multiple lines and change all of them at one time 
� Add your own bullet graphic by using the Picture button at the bottom of the 

Bullets and Numbering dialog box to find a picture from a clip gallery 
 
Tip:  Wingdings fonts are good to use for bullets since they consist mainly of symbols. 

Insert a Graphic 
There are a couple ways to insert a graphic into a slide:  

1. Go to Insert menu / Picture / Clip Art…  to search the clip art gallery for 
graphics. 

2. Go to the Insert menu / Picture / From File… to search your computer or a disk 
to find a saved graphic. This graphic could be a logo or a graphic scanned from a 
magazine that you want to use in your presentation. 

Resizing a Graphic 
Move or resize the graphic as necessary. Keep in mind that you can alter the shape and 
position of the text boxes to make room for the inserted graphics. Be careful that the 
size and nature of the graphic are appropriate for use as a bullet or picture to support 
your presentation. 
 

� Click once on the graphic to activate the sizing handles 
 

 
 

To size… 
 

 
Proportionally from all sides. 

 
Hold down the CTRL key and drag one of the 
corner sizing handles in or out 
 

 
Vertically or horizontally from the center. 
Caution: This could distort the graphic. 
 

 
Hold down the CTRL key and drag a sizing 
handle in or out. 
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Adding Default Text or Graphics to Each Slide 
Adding the same text or a logo to each slide in your presentation is easy.  
 

1. Open the slide master: View / Master / Slide Master 

2. Insert a Text Box from the Drawing Toolbar   
If the Drawing toolbar is not visible: Go to View menu / Toolbars / ���� Drawing 

3. Type text in the text box 
4. To insert a graphic in the box, make sure your cursor is in the text box 

o Go to Insert menu / Picture / choose from Clip Art… or From File… 
 

Note:  The look of the text you've added with the Text Box button is not controlled by 
the slide master. 

Create Slides that are Different from the Slide Master 
Create unique slides by modifying individual slides. These slides retain their uniqueness 
even when you change the slide master or apply a new design template.  
 

� In Normal View, simply select the slide object and make changes 
 

Note: Objects appear on slides in the same location as they do on the slide master. 

Creating a Custom Design Template 
Save your custom design as a template and use it in future presentations.  

1. Open an existing presentation, or use a design template to create a presentation 
as a basis for your new design template 

2. Change the template or presentation to suit your needs 
3. On the File menu, click Save As 
4. In the File name box, type a name for your design template 
5. In the Save as type box, click Design Template 

 
Tip:  Save your new custom design template in the Presentation Design folder with 
other design templates for easy access.  
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Custom Animation 
 
 

 

 

Customize the Order & Timing of 
Slide Objects 

 
Choose to animate any, all, or none of the 
slide objects 
 
 
Order & Timing of Animation 
� Mouse click 
� Automatically after X number of 

seconds 
 
 
Preview the custom animation 

 
 

 

 
 

 

 
 

 
Customize the Effects 

 
Choose custom effects for each slide object 
by clicking on the object to select it 
 
Choose entry animation and sound 

� Transition 
� Entry into the slide 
� Sound 

 
After animation 

� Hide or dim the bulleted title or 
bulleted points to de-emphasize 

 
Introduce text 

� All at once 
� By Word 
� By Letter 
� Group by levels 
� In reverse order 
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Action Buttons 
Inserting action buttons into your slides allows you to navigate your way though a 
presentation. If you want the same action buttons to appear on every slide, put them on 
the slide master. 

 

� Select the slide you that you would like to have action button(s) 
o Place buttons on every slide by going to View / Master / Slide Master 

Tip:  The footer is a good place to put action buttons 
� To insert buttons go to Slide Show / Action Buttons and select the button you 

want to use 
� Insert a button by clicking the slide 
� Resize the button by dragging it to the size you want 

Tip:  To maintain the shape's width-to-height ratio, hold down SHIFT key as you 
drag one of the corner sizing handles. 

� When the Action Settings dialog box appears, click OK to accept the proposed 
hyperlink in the Hyperlink to list, or specify the action and link you want.  

o Activate action buttons during the presentation by single clicking on the 
button or moving the mouse over the button.  
Be careful when using the mouse over option!  

Tip:  Use Action Settings to link any PowerPoint object (action button, slide title, 
slide bulleted item, graphic, chart, table, graph, etc.) to a slide, file, or web site.  

 
 
Custom 

 
Home 

 
Help 

 
Info 

 
Back  
or 
Previous 

 
Forward 
or  
Next 

 
Beginning 

 
End 

 
Return 

 
Document 

 
Sound 

 
Movie 
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Hyperlinks 
Use hyperlinks in your presentation to quickly access web sites, files, or other 
PowerPoint presentations. 
 

Note:  You can only access web sites via hyperlinks if your computer has access to the 
internet.  
 
 

 

 
Highlight the text or picture that you 
want to set up the hyperlink for 
 
Go to Insert menu / Hyperlink 
(or right click)  
 
Find the file or web page for linking: 

� Type in the web address 
� Browse for saved files 
� Choose from the list 

 
Click OK  
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Action Settings 
 

 

 
 

 
Activate action buttons during the 
presentation by single clicking on the 
button 
 
Choose to hyperlink each action button 
separately to a slide, file, other 
PowerPoint presentation, or web site:  

 
 
Play a sound (or not) when the button is 
activated 
 
Click OK 

 

 
 

 
Activate action buttons during the 
presentation by simply moving the 
mouse over the button.  
Be careful when using this option!  
 
Choose to hyperlink each action button 
separately to a slide, file, other 
PowerPoint presentation, or web site:  

 
 
Play a sound (or not) when the button is 
activated 
 
Click OK 
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Slide Transition 
The slide transition determines the way the slides flow one after another in the 
presentation.   
 

 
 

Effect 
� Allows you to preview the slide transition 
� Choose an effect from the list 
� Choose a speed (slow, medium, fast) 

 
Advance 

Two ways to advance to the next slide: 
1. Click the mouse 
2. Automatically after a set amount of time 

 
Sound 

Choose sounds or no sound from the list 
 

Apply 
� Click Apply to All to apply the transition to 

all the slides in your presentation 
� Click Apply to apply the transition to the 

selected slide 
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Preset Animation 
Preset animation is a quick way to create basic animation for your slide objects and text. 
It allows you easy access to use some of the most popular animations. 
 

� Simply select the object you want to animate 
� Go to the Slide Show menu / Preset Animation and then click the option you 

want to use 
 
Tip:  Use preset animation to animate charts. 
 
 

Preset Animation Animation 
The object or text… 

Sound 

Off 
 

Removes any preset or custom animation 
settings from the selected text or object 

 

Drive-in Flies in from the right side of the slide Car 
Flying Flies in from the left side of the slide Whoosh 
Camera Appears like a camera shutter is opening Camera click 
Flash Once Appears briefly, then disappears  
Laser Text Flies in from the top-right corner of the slide Laser 

Text: Characters 
appear one at a time 

Typewriter Appears one character at a time Typewriter 
Reverse Order Appears from the bottom up 

Note:  If you apply the effect to a bullet list, the 
last item in a bullet list appears first. 

 

Drop-in Drops in from the top of the slide, text appears 
one word at a time 

 

Fly from Top Flies from the top Whoosh 
Animate Chart Animates the selected chart  
Wipe Right Appears from left to right  
Dissolve Appears gradually on the slide, starting out at 

low resolution 
 

 

Split Vertical Out Appears from the center to the left and right  
Appear Simply appears at its time in the animation order  
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Custom Shows 
The custom shows feature allows you to create a presentation within a presentation. In 
order to create a custom show, the slides that make up the custom show must be a part 
of the original presentation. Custom show is useful when creating multiple, almost 
identical presentations for different audiences. Group the slides that differ together, 
name the show, and then go directly to these slides during your presentation. 

Setting up a Custom Show 
� Go to the Slide Show menu / Custom Shows… 
� Define a custom show 

o Name the show 
o Add the slides in the custom show 
o Change the order of the slides by using the up and down arrows 

� Click OK 
� Access the custom show 

1. Before the presentation begins, set up a hyperlink to the custom show 
Slide Show menu / Action Settings  / Hyperlink to: / Custom Show… 

2. During a presentation  
Right-click to access the shortcut menu / Go / Custom Show / click the 
show you want to run 

 
Tip:  After creating a custom show, edit it by adding or removing slides from the show. 
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Set Up Show 
Set up Show allows you to manage the way you present your slide show as a speaker, 
to an individual, or at a trade show kiosk.  
 

� Choose your show type and appearance on the screen 
� Loop the slide show until the Esc key is pressed 
� Show without narration or animation 
� Choose the slides you want to show: all, range of slides, or a custom show 
� Advance the slides manually or after a length of time 
� Choose your pen color for making marks on slides 

The pen feature will only work with Presented by a speaker (full screen) 
 
Note:  Show scrollbar can only be used with Browsed by an individual (window) 
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Using the Shortcut Menu While Running Your Slide Presentation 
 

 

 
 

 
Right click on any 
slide to display 
the shortcut menu 
while running 
your slide 
presentation. 

 
 

 
 

 
Use Go / By Title to display a list of all 
your slide titles. This enables you to 
navigate your way through the slides 
(forward or backward) without stopping 
your presentation.  

 
 

 
 

 
Use Pointer Options / Pen to activate a writing tool for 
making comments or drawing on slides. All marks made 
on the slides are temporary. Change the pen color so 
markings will show up on the slide background color.  

 


